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Abstract

Accurately and reliably identifying spatial orientation of the isolated mouse retina is important for many studies in visual neuroscience, including
the analysis of density and size gradients of retinal cell types, the direction tuning of direction-selective ganglion cells, and the examination
of topographic degeneration patterns in some retinal diseases. However, there are many different ocular dissection methods reported in the
literature that are used to identify and label retinal orientation in the mouse retina. While the method of orientation used in such studies is often
overlooked, not reporting how retinal orientation is determined can cause discrepancies in the literature and confusion when attempting to
compare data between studies. Superficial ocular landmarks such as corneal burns are commonly used but have recently been shown to be
less reliable than deeper landmarks such as the rectus muscles, the choroid fissure, or the s-opsin gradient. Here, we provide a comprehensive
guide for the use of deep ocular landmarks to accurately dissect and document the spatial orientation of an isolated mouse retina. We have
also compared the effectiveness of two s-opsin antibodies and included a protocol for s-opsin immunohistochemistry. Because orientation of
the retina according to the s-opsin gradient requires retinal reconstruction with Retistruct software and rotation with custom code, we have
presented the important steps required to use both of these programs. Overall, the goal of this protocol is to deliver a reliable and repeatable set
of methods for accurate retinal orientation that is adaptable to most experimental protocols. An overarching goal of this work is to standardize
retinal orientation methods for future studies.

Video Link

The video component of this article can be found at https://www.jove.com/video/57861/

Introduction

An important and sometimes overlooked aspect of retinal neuroscience is the proper orientation and analysis of the isolated whole-mount retina,
whether it be the orientation of a retina in an electrophysiology recording chamber or on a histological slide. This is particularly important for
studies involving the mouse retina, which is currently the most widely used model for investigations of the mammalian visual system. Recent
discoveries reveal that the mouse retina is not spatially uniform but has density and size gradients of functionally-distinct retinal cell types, such
as melanopsin ganglion cells, transient OFF-alpha ganglion cells, and cone opsins1,2,3,4,5. Consequently, the method used to determine the
orientation of the retina may affect the experimental results involving cell type or opsin distributions2,3,6, direction tuning of direction-selective
ganglion cells7,8,9, and topographic patterns of retinal degeneration10,11,12,13,14. In fact, not reporting how retinal orientation is reported can cause
discrepancies in the literature and confusion when attempting to compare data between studies. It is therefore vital that researchers report the
method for identifying the orientation of the retina so that results of such studies can be accurately interpreted.

Retinal orientation is commonly identified by scoring the dorsal, ventral, nasal or temporal cornea prior to ocular enucleation1,3,12,15,16,17,18,19

or by cutting or staining deep anatomical eye landmarks such as the extraocular muscles6,7, the choroid fissure20,21, or the s-opsin gradient2,3.
The rectus muscles can be used to identify the dorsal, ventral, nasal, and temporal retina by making a deep relieving cut that bisects the
attachment of the either the superior rectus, inferior rectus, medial rectus, or lateral rectus muscle, respectively. However, for most experiments,
using one rectus muscle is sufficient for orienting the retina22. The choroid fissure, which is a remnant of eye development, can be viewed as
a faint horizontal line on the back of the eye. Each end of this line terminates at either the nasal or the temporal pole of the globe23. Finally, s-
opsin expression is asymmetrically distributed to the ventral retina in mice, and s-opsin antibodies can be used to reveal the ventral retina in
immunohistochemical experiments1.

Recent work by Stabio, et al.22 demonstrated that superficial ocular landmarks such as corneal burns are a less reliable method for orienting
the retina in anatomical space, most likely due to human error and variability in making the corneal burn when using the temporal and medial
canthi as reference points. In contrast, deep landmarks, such as the superior rectus muscle, choroid fissure, and the s-opsin gradient, have been
shown to be more reliable and accurate landmarks for orienting the retina22. However, the identification of these anatomical landmarks requires
unique dissection steps that are not described in detail in the literature. Thus, the goal of this protocol is to provide a comprehensive tutorial on
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how to use the superior rectus muscle, choroid fissure, and s-opsin gradient to accurately identify the spatial orientation of the mouse retina. In
addition, we have included a comparison of the effectiveness of two s-opsin antibodies, as well as a protocol for s-opsin immunohistochemistry.

One additional challenge to studies relying on precise retinal orientation is the large relieving cuts required to flatten wholemount retinas on a
recording chamber, dish, or slide. This can introduce challenges for the analysis of what is naturally a three-dimensional structure when it is
imaged as a flat two-dimensional structure. A program called Retistruct24 can be used to return a flat wholemount retina to its three-dimensional
structure before the data collected from it is analyzed. Thus, a section of this protocol is dedicated to highlighting the steps that are necessary
for using the Retistruct software to reconstruct s-opsin immunostained mouse retinas. We have also included a section of protocol for using our
custom MATLAB script, which was developed to accurately rotate and orient mouse retinas stained with s-opsin.

Protocol

All methods described here have been approved by the Institutional Animal Care and Use Committee (IACUC) of The University of Akron.

1. Using the Superior Rectus Muscle Landmark to Identify Retinal Orientation

NOTE: The superior rectus muscle is a landmark for the dorsal retina (Table 1). If the experiment does not require the marking of the dorsal
retina, skip step 1 and continue to step 2.

1. Follow your approved Institutional Animal Care and Use Committee protocol for mouse euthanasia.
2. To identify the general orientation of the globe, make a burn mark on the dorsal cornea directly between the nasal and temporal canthi near

the cornea-sclera border immediately after euthanasia (Figure 1A). Make the burn mark by heating up a cautery pen for ten seconds and
then touching the tip of the pen to the dorsal cornea for less than a second.
 

NOTE: Holding the cautery pen to the cornea for too long will cause the globe to puncture.
 

NOTE: While some cautery pens do emit light, the cautery pen listed in the Table of Materials does not emit any light when heated, making it
a safe option for dark-adapted experiments.

3. For enucleation, use curved forceps to gently push the eye out of its socket and grip the globe from underneath. Do not cut the optic nerve
to remove the globe; instead, slowly lift the globe from its socket while simultaneously moving it gently from left to right until the globe is
released from the socket.
 

NOTE: This motion will allow the rectus muscles to remain attached to the globe when the globe is finally removed completely from the
socket. The optic nerve will also often remain attached to the globe.

4. Transfer the globe with the attached rectus muscles in a Petri dish containing dissection medium. Make sure to keep track of which eye is the
left eye and which is the right eye.
 

NOTE: The dissector should use an appropriate dissection medium that aligns with their experimental protocol.
5. Under the dissection scope, visually locate the dorsal corneal burn and identify the superior rectus muscle with which it is associated (Figure

1A).
6. Using dissection scissors or a 20 G (0.9 mm x 25 mm) needle (see Table of Materials), puncture the cornea at the burn mark. Make a deep

relieving cut into the globe toward the optic nerve to bisect the superior muscle. An isolated and reconstructed retina with this cut is shown in
Figures 1B and 1C.

7. Begin to isolate the retina by using two sets of forceps (see Table of Materials) to gently tear the hole made with the puncture in step 1.6
until part of the retina is exposed.
 

NOTE: It is important that this be done gently, as tearing too forcefully can cause the relieving cut to tear further.
8. Use forceps to tease apart the retina from the sclera until the sclera has been completely removed. Remove the iris, lens, vitreous, and any

remaining structures with forceps until the retina is completely isolated.
 

NOTE: The protocol may be paused here. If the tissue is going to be fixed for s-opsin immunohistochemistry, continue to step 3.5.

2. Using the Choroid Fissure Landmark to Identify Retinal Orientation

NOTE: The choroid fissure is present on the sclera on the back of the eye, and runs from the temporal pole to the nasal pole (Figures 2B and
2C; Table 1).

1. Follow approved Institutional Animal Care and Use Committee protocol for mouse euthanasia.
2. To identify the general orientation of the globe, make a burn mark on the dorsal cornea directly between the nasal and temporal canthi near

the cornea-sclera border immediately after euthanasia (Figure 2A). Make the burn mark by heating up a cautery pen for ten seconds and
then touching the tip of the pen to the dorsal cornea for less than a second.
 

NOTE: Holding the cautery pen to the cornea for too long will cause the globe to puncture.
3. Enucleate the eye and transfer the globe in a Petri dish containing dissection medium. Make sure to keep track of which eye is the left eye

and which is the right eye.
 

NOTE: The dissector should use an appropriate dissection medium that aligns with their experimental protocol.
4. Visually locate and identify the choroid fissure on the back of the eye (Figure 2B, 2C).

 

NOTE: The choroid fissure is also visible inside the eyecup under infra-red light20.
5. Orient the globe in the Petri dish so that the dorsal burn is located at the superior pole, as it would be if the eye were still in the mouse.

 

NOTE: The presence of the dorsal burn allows for the identification of the nasal and temporal side of the globe, as long as whether it is a right
or left eye has been documented: If it is a right eye, the nasal choroid fissure will be to the right of the burn and the temporal choroid fissure
will be to the left of the burn. If it is a left eye, the temporal choroid fissure will be to the right of the burn and the nasal choroid fissure will be
to the left of the burn.
 

Using dissection scissors or a 20 G (0.9 x 25 mm) needle (see Table of Materials), make one puncture in the globe where the dorsal burn is
located.
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6. Make a shallow relieving cut toward the optic nerve where the dorsal corneal burn is located. This cut will be perpendicular to the choroid
fissure, allowing for identification of the dorsal retina after isolation (Figure 2D).

7. Make the following two deep relieving cuts toward the optic nerve: one by lining the blades of the dissection scissors up with the temporal
choroid fissure line on the back of the eye, and one by lining the blades of the dissection scissors up with the nasal choroid fissure line on the
back of the eye. These cuts are shown on an isolated and reconstructed retina in Figure 2D and 2E.
 

NOTE: Alternatively, a deep cut can be made at the temporal choroid fissure and a shallow cut can be made at the nasal choroid fissure,
making the dorsal corneal burn cut unnecessary. This allows for accurate orientation of the retina with fewer relieving cuts.

8. Begin to isolate the retina by using two sets of forceps (see Table of Materials) to gently tear the hole made with the puncture in steps 2.7
and 2.8 until part of the retina is exposed.
 

NOTE: It is important that this be done gently, as tearing too forcefully can cause the relieving cut(s) to tear further.
9. Use forceps to tease apart the retina from the sclera until the sclera has been completely removed. Remove the iris, lens, vitreous, and any

remaining structures with forceps until the retina is completely isolated.
 

NOTE: The protocol may be paused here. If the tissue is going to be fixed for s-opsin immunohistochemistry, continue to step 3.5.

3. Labeling the S-opsin Gradient in the Mouse Retina

NOTE: The s-opsin photopigment expression is asymmetrically distributed to the ventral retina1, making it an excellent marker for the ventral half
of the retina. This method is only useful for fixed and immunostained tissue (Table 1). The following steps can be applied to retinas that have
been dissected using any of the aforementioned methods.

1. Follow approved Institutional Animal Care and Use Committee protocol for mouse euthanasia.
2. Immediately after euthanasia, enucleate the eye and place the globe in a Petri dish with dissection medium. Make sure to keep track of which

eye is the left eye and which is the right eye in order to identify retinal orientation after the retina is dissected.
 

NOTE: The dissector should use an appropriate dissection medium that aligns with their experimental protocol.
3. Begin to isolate the retina by using two sets of forceps (Table of Materials) to gently tear a hole in the cornea until part of the retina

is exposed.
 

NOTE: It is important that this be done gently, as tearing too forcefully can cause the retina to tear.
4. Use forceps to tease apart the retina from the sclera until the sclera has been completely removed. Remove the iris, lens, vitreous, and any

remaining structures with forceps until the retina is completely isolated.
 

NOTE: The protocol may be paused here. If using the retina for an ex vivo experiment, conduct the experiment before performing the
following steps.

5. Using dissection scissors, make four relieving cuts in the retina so that it will lie flat. Mount the retina ganglion cell-side up on nitrocellulose
membrane (Table of Materials) by gently pressing each corner of the retina onto the membrane with forceps.
 

NOTE: The location of the relieving cuts can be arbitrary when using the s-opsin gradient for retinal orientation.
6. Using forceps, transfer the mounted retina to the first well in a 24-well plate (Table of Materials) filled with 1 mL of 4% paraformaldehyde

(Table of Materials) for fixation. Place the 24-well plate on an orbital shaker at room temperature (Table of Materials) and fix the retina for
exactly 40 min.
 

NOTE: All of the following wash and incubation steps should be completed with the 24-well plate on an orbital shaker.
7. Wash the retina for 15 min at room temperature by transferring it to the second well filled with 1 mL of 0.1 M PBS. Repeat this step twice by

sequentially transferring the retina to the 0.1 M PBS-filled third and fourth wells.
8. Transfer the mounted retina to the fifth well containing 1 mL of blocking solution (1.7% Triton X-100 and 5.2% donkey normal serum in 0.1 M

PBS; see Table of Materials) and incubate overnight at 4 °C.
9. Add the rabbit anti-s-opsin primary antibody (see Table of Materials) to the blocking solution at a concentration of 1:500 and incubate for

three days at 4 °C.
10. Wash the excess primary antibody from the retina six times by sequentially placing it in six wells filled with 1 mL of 0.1 M PBS for 10 minutes

each at room temperature.
11. Place the retina in a well with fresh blocking solution (1.7% Triton X-100 and 5.2% donkey normal serum in 0.1 M PBS) and add donkey anti-

rabbit Alexa-594 secondary antibody (see Table of Materials). Incubate the retina with the secondary antibody overnight at 4 °C.
12. Wash the excess secondary antibody from the retina six times by sequentially placing it in six wells filled with 1 mL of fresh 0.1 M PBS for 10

min each at room temperature.
13. Using forceps, transfer the mounted retina to a Petri dish containing 0.1 M PBS. Release the retina from the nitrocellulose membrane by

gently inserting the tips of forceps between the retina and the membrane until the retina is no longer attached.
14. Mount the retina on a glass microscope slide by gently prodding it with forceps until the retina sticks to the glass and remove the slide from

the Petri dish.
15. Cover the retina on the slide with Aquamount and cover it with a #1.5 coverslip. Place the slide in a slide tray (see Table of Materials) and

allow it to sit at room temperature for an hour.
16. Return the slide to the refrigerator and store in a slide tray (see Table of Materials) at 4 °C when not in use. After the slide has been

coverslipped for 24 hours, use nail polish to seal the sides of the slide to prevent desiccation.
 

NOTE: The protocol can be paused here.

4. Using Reconstructed Retinas Immunostained with S-opsin to Identify Retinal Orientation

1. Visualize the s-opsin gradient with either a confocal microscope or an epifluorescent microscope with a camera attachment (see Table of
Materials) and image the retina so that the entire retina is visible in one image (Figures 1B, 2D, 3A, and 3D). This can be done by imaging
the retina in sections at low magnification and then stitching the images together.

2. Name the retinas so they are identifiable. For example, name the first retina to be reconstructed "Retina1".
3. Download and install ImageJ at https://imagej.nih.gov/ij/download.html.
4. Create an individual folder for each retina that needs to be reconstructed, but leave the folders empty. For example, create a folder titled

"Retina1". All files needed to reconstruct this retina will be placed in this folder in the subsequent steps.
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NOTE: The only files these folders should contain are the files that are to be analyzed by Retistruct. Any files other than the ones detailed
below will make the retina unable to be opened by the Retistruct software.

5. Open the image of the retina in ImageJ by selecting File → Open and then choosing "Retina1".
6. Without making any changes to the image, save it as "image.png" to the folder titled "Retina 1" by selecting File → Save As → PNG.

 

NOTE: The file must be named "image.png" in order for the Retistruct software to recognize the file as a retina for reconstruction.
7. Use the Segmented Line Tool to outline the edges of the retina. By clicking on two adjacent spots on the border of the retina, the segmented

line tool will essentially "connect the dots" between the two adjacent spots, creating an outline. Repeat until the entire retina has been
outlined. Save the retina outline as "outline.roi" to the folder titled "Retina1" by selecting Analyze → Tools → ROI manager → Add[t] → More
→ Save.
 

NOTE: The edge of the retina can be identified where the s-opsin staining transitions to the background.
8. Use the Segmented Line Tool as instructed in step 4.7 to outline the border of the optic disc. Save the optic disc outline as "od.roi" to the

folder titled "Retina1" by selecting Analyze → Tools → ROI manager → Add[t] → More → Save.
 

NOTE: The optic disc is identified as the small hole in the middle of the retina, and will vary based on the quality of dissection.
 

NOTE: All of the files needed for Retistruct reconstruction ("image.png", "outline.roi", and "od.roi") should now be saved the folder "Retina1".
9. To download, install, and open the Retistruct program, follow the instructions outlined in the Retistruct user guide found in the Supplementary

Materials section of Sterratt, et al.24

10. Once the Retistruct window has appeared, click the "Open" icon at the top left of the window and select the directory folder "Retina1".
11. An image window will pop up indicating that no scale bar exists. Click "Close" and an image of the retina will appear in the box. Visualize the

outline of the retina by clicking the "Properties" button in the top right of the window and change outline color to a visible color (Figure 5A).
12. IMPORTANT: Specify whether the retina is from a right eye or left eye in the panel on the left (Figure 5A).
13. Click the "Add Tear" button on the left and specify where a tear or cut is in the retina by clicking on the three vertices of the tear (Figure 5A).

This will create lines that connect the three vertices of the cut. Repeat for all cuts in the retina.
14. Specify the dorsal retina by clicking on an arbitrary point of the retinal outline. An uppercase letter "D" will appear at that point on the outline

(Figure 5B).
 

NOTE: The dorsal retina will be the darker half of the retina, opposite the s-opsin gradient. However, marking the dorsal retina in Retistruct is
not a reliable method for identifying the dorsal half of the retina, so the marking of "dorsal" can be arbitrary in this step.

15. Reconstruct the retina by clicking the "Reconstruct Retina" button at the top left of the screen (Figure 5B). A polar plot of the reconstructed
retina will appear with the cuts visible in the same color as the outline (Figure 5C).

16. Click the "Save" button on the right of the screen so that the reconstructed retina and all of the data associated with it is saved in the
"Retina1" folder directory (Figure 5D).

17. Save the reconstructed retina by clicking the "PDF" button in the right-hand panel (Figure 5D). A box will appear asking for size
specifications. The default size is acceptable for the following steps. This action will save the reconstructed retina as "image.polar.pdf" in the
"Retina1" folder directory.

18. Open "image.polar.pdf" in a Paint program (or other image manipulation program) and use the "Paint Bucket" tool (or similar) to change
the background of the reconstructed retina to black. Save the reconstructed retina as a .tif file, such as "Retina1_reconstructed.tif" in the
"Retina1" folder directory.
 

NOTE: The protocol can be paused here.
19. Download the MATLAB code for rotating the retina called "Retina_Rotator.m" (see Supplementary Materials). Place the code file in its own

folder with no other files in the folder.
20. Open MATLAB, version 2007b or later. Double click on the code file to open it in MATLAB. In the command window, type "Retina_Rotator"

and then hit the enter key. A search window will appear.
 

NOTE: The code is specific for .tif files. If the file to be rotated is not in the correct format, the code will not rotate the retina correctly. See
steps 4.17 and 4.18. for saving the reconstructed retina in the proper format.

21. Open the file to be rotated. For example, choose "Retina1_reconstructed.tif". The code will then analyze the reconstructed retina and will
automatically save the rotated retina as "Retina1_reconstructed_rotated.tif" in the folder where the original file is located.

22. After the code has finished analyzing the retina, a window will also appear showing the images of the retina before and after rotation for
comparison (Figures 3B and 3C; Figures 3E and 3F).
 

NOTE: This code rotates the reconstructed retina so that the ventral (brightest) half is on the bottom and the dorsal (dimmest) half is on
the top, thus accurately orienting the retina according to the s-opsin gradient1. If whether the retina is from a right eye or left eye has been
documented, the location of the nasal and temporal poles can also be extrapolated from this method of orientation (Figure 3).

Representative Results

A single relieving cut that bisects the superior rectus muscle accurately and reliably identifies the dorsal retina (Figure 1). The choroid fissure
accurately and reliably identifies the nasal and temporal retina with deep relieving cuts along the temporal and nasal choroid fissure (Figure 2).
In this example, a relieving cut has also been made in the dorsal retina in order to identify the dorsal/ventral axis of the retina (Figure 2D, vertical
arrow). The steps of these processes are shown for purpose of replication by future dissectors. A combination of s-opsin immunohistochemistry
(Figure 3A and 3D), reconstruction with Retistruct software (3B, 3E) and accurate rotation with a custom MATLAB code (3C, 3F) allows for the
identification of the ventral and dorsal halves of the retina, as well as the nasal and temporal poles if it is known whether the retina is from a right
or left eye (Figure 3). We also compared two commonly used s-opsin primary antibodies for effectiveness in labeling s-opsin cones (Figure 4A-
D): Both the goat anti-s-opsin primary antibody and the rabbit anti-s-opsin primary antibody effectively label s-opsin cones (Figure 4E) in the
same mouse.

https://www.jove.com
https://www.jove.com
https://www.jove.com


Journal of Visualized Experiments www.jove.com

Copyright © 2018  Creative Commons Attribution-NonCommercial-NoDerivs 3.0 Unported
License

August 2018 |  138  | e57861 | Page 5 of 11

Relieving cuts were identified on s-opsin immunostained reconstructed retinas and their locations were compared to the orientation determined
by the s-opsin gradient. Using our custom MATLAB code (see Supplemental Materials), retinas were accurately rotated so that the highest
concentration of s-opsin staining is located ventrally, thus placing true dorsal at 90° (for superior rectus), true nasal at 0° (for nasal choroid
fissure) and true temporal at 180° (for temporal choroid fissure). The value of each individual relieving cut angle was determined using the angle
tool in ImageJ after retinas were rotated according to the s-opsin gradient. An average angle was calculated for each relieving cut type and the
average value of each relieving cut type was then plotted on a polar plot (Figure 6). On average, superior rectus muscle cuts identified the dorsal
pole at 96.3 ± 4.3° (n = 11) (Figure 6). The nasal choroid fissure identified the nasal pole at 6.7 ± 5.8° and the temporal choroid fissure identified
the temporal pole at 172.0 ± 4.4° (n = 9; Figure 6).

 

Figure 1: Using the superior rectus muscle to accurately identify the dorsal retina of a right eye. (A) An example of a dorsal corneal burn
near the corneal-scleral border made with a cautery tip pen (white arrow). The superior rectus muscle is also visible in this view (white arrow).
(B) An example of a whole mounted retina with a relieving cut made in the dorsal retina by bisecting the superior rectus muscle. Arrow depicts
the deep relieving cut made in the dorsal retina by bisecting the superior rectus muscle. The retina is stained with primary antibody goat anti-s-
opsin (see Table of Materials) and secondary antibody donkey anti-goat Alexa 594 (see Table of Materials; excitation: 590 nm; emission: 620
nm) (cyan). Retina was imaged with an epifluorescent microscope with a Texas Red filter (595 nm). (C) A retina reconstructed in Retistruct and
rotated with a custom MATLAB code (see Supplemental Materials) with the superior rectus muscle relieving cut visible (white arrow). D: dorsal,
V: ventral, T: temporal, N: nasal. Scale bars = 1 mm. Please click here to view a larger version of this figure.

 

Figure 2: Using the choroid fissure to accurately identify the nasal and temporal poles of the retina of a right eye. (A) An example of
a dorsal corneal burn near the corneal-scleral border made with a cautery tip pen. (B) The choroid fissure visible on the back of the eye on the
sclera (white arrow). The dorsal corneal burn is also visible in this view, located about 90° from the temporal choroid fissure. (C) The choroid
fissure visible on the back of the eye on the sclera, traveling from the optic nerve to the corneal-scleral border. (D) A retina stained with goat anti-
s-opsin (see Table of Materials) and secondary antibody donkey anti-goat Alexa 594 (see Table of Materials; excitation: 590 nm; emission: 620
nm) (cyan) with choroid fissure cuts (horizontal arrows) and the dorsal relieving cut (vertical arrow). Retina was imaged with an epifluorescent
microscope with a Texas Red filter (595 nm). (E) A retina reconstructed in Retistruct and rotated with a custom MATLAB code (see Supplemental
Materials) with the dorsal relieving cut and the nasal and temporal choroid fissure cuts visible (white arrows). D: dorsal, V: ventral, T: temporal, N:
nasal. Scale bars = 1 mm. Please click here to view a larger version of this figure.
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Figure 3: Using the s-opsin gradient to identify all four poles of the retina. (A) An example of a retina dissected from a right eye that has
been immunostained to label s-opsin and imaged with an epifluorescent microscope with a Texas Red filter (595 nm). The cuts in this retina
are arbitrary since the topographical orientation is determined by the s-opsin gradient. (B) The results of reconstructing the retina in A with
Retistruct. Notice that the s-opsin gradient is not correctly aligned because the retina has not been run through the custom MATLAB code (See
Supplemental Materials). (C) The results of rotating the retina in A with the custom code. The retina has been rotated so that the highest
concentration of s-opsin staining is located at the bottom and identified as the ventral retinal. Because the retina is from a right eye, the temporal
pole is located 90° counterclockwise from the dorsal pole and the nasal pole is located 90° clockwise from the dorsal pole. (D) An example of
a retina dissected from a left eye that has been immunostained to label s-opsin and imaged with a Texas Red filter (595 nm). The cuts in this
retina are arbitrary since the topographical orientation is determined by the s-opsin gradient. (E) The results of digitally reconstructing the retina
in D with Retistruct. Notice that the s-opsin gradient is not correctly aligned because the retina has not been rotated by the custom code. (F)
The results of rotating the retina in D with the custom code. The retina has been rotated so that the highest concentration of s-opsin staining is
located at the bottom and identified as the ventral retinal. Because the retina is from a left eye, the nasal pole is located 90° counterclockwise
from the dorsal pole and the temporal pole is located 90° clockwise from the dorsal pole. D: dorsal, V: ventral, T: temporal, N: nasal. Scale bars =
1 mm. Please click here to view a larger version of this figure.
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Figure 4: Comparison of two primary s-opsin antibodies in labeling s-opsin cones. (A) A retina stained with the goat anti-s-opsin primary
antibody (see Table of Materials). (B) The other retina of the same mouse stained with rabbit anti-s-opsin primary antibody (see Table of
Materials). (C) A representative region (0.1 x 0.1 mm2) from a retina stained with the goat anti-s-opsin primary antibody. Image taken on an
epifluorescent microscope at 40X magnification. (D) A representative region (0.1 x 0.1 mm2) from a retina stained with rabbit anti-s-opsin (see
Table of Materials), a primary antibody alternative. Image was taken on an epifluorescent microscope at 40X magnification. (E) Both antibodies
label the same number of s-cone outer segments because there is no significant difference in the number of immunopositive s-cones that are
stained by goat anti-s-opsin and rabbit anti-s-opsin at any of the tested retinal eccentricities (n = 2; ANOVA with post hoc Bonferroni test; p
>0.05). Scale bars = 1 mm (A-B); 25 µm (C-D). Please click here to view a larger version of this figure.
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Figure 5: A visual guide for using the Retistruct software to reconstruct retinas immunostained with s-opsin. (A) A retina opened in
Retistruct with the outline visible and a "Tear" added. Points of the "Tear" are indicated with superimposed white arrows. All cuts in this retina
are arbitrary, as no particular landmark was used to mark retinal orientation during dissection. Important buttons are outlined in red. (B) A retina
with all "Tears" added and the dorsal retina identified with "D" on the edge of the retina. Notice that the "Reconstruct Retina" button is now
visible. Important buttons are outlined in red. (C) The process of reconstructing a retina. The polar plot of the reconstructed retina will appear on
the right, showing the relieving cuts in cyan (blue arrows superimposed to clarify cut locations). (D) The final result of running a retina through
Retistruct. The original wholemount retina remains on the left and the reconstructed retina appears on the right. The relieving cuts are visible in
cyan (white arrows superimposed to clarify cut locations). Please click here to view a larger version of this figure.
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Figure 6: The superior rectus muscle and choroid fissure can be used to accurately orient the mouse retina. A polar plot of the angles
obtained from either superior rectus muscle relieving cuts or choroid fissure cuts in retinas that have been reconstructed with Retistruct.
Relieving cuts were identified on s-opsin immunostained reconstructed retinas and their locations were compared to the location of the s-
opsin gradient. Using the custom MATLAB code to accurately rotate the retinas so that the highest concentration of s-opsin staining is located
ventrally, true dorsal (90° for superior rectus), true nasal (0° for nasal choroid fissure) and true temporal (180° for temporal choroid fissure) were
determined for each retina. The value of each individual relieving cut angle was determined in ImageJ and an average angle was calculated
for each relieving cut type. Superior rectus muscle cuts identified the dorsal pole at 96.3 ± 4.3° (n = 11). The nasal choroid fissure identified the
nasal pole at 6.7 ± 5.8° and the temporal choroid fissure identified the temporal pole at 172.0 ± 4.5° (n = 9). Please click here to view a larger
version of this figure.

Deep Landmark Corneal Burn Location Pole of Retina Identified Experimental Application

Superior Rectus Dorsal Dorsal Live or Fixed

Nasal Choroid Fissure Dorsal Nasal Live or Fixed

Temporal Choroid Fissure Dorsal Temporal Live or Fixed

S-opsin Gradient None Dorsal, Ventral, Nasal, Temporal Fixed

Table 1: Deep landmarks, the pole of the retina they identify, and whether they can be used for live or fixed tissue application.

Discussion

There has been no comprehensive, standardized protocol for determining and labeling the orientation of the isolated mouse retina in anatomical
space. The protocol detailed here attempts to fill this void by standardizing and detailing how to use deep anatomical landmarks as reference
points to reliably identify retinal orientation. It has been shown that the deep anatomical landmarks in this protocol provide a more accurate and
reliable method for orienting the mouse retina than superficial landmarks such as corneal burns22. Thus, studies that have relied on corneal
burns for retinal orientation may have had greater errors in orientation than studies that have relied on landmarks such as the rectus muscles
and choroid fissure. This discrepancy highlights the need for and significance of this standardized protocol with respect to interpreting results
and making comparisons between studies that depend upon accurate retinal orientation. Overall, a standardized protocol will provide a common
method for vision researchers to follow, thus eliminating the presence of a confounding variable in data acquisition that may occur with the use of
non-standardized methods for identifying retinal orientation.

The methods presented here are easily repeatable and applicable to many types of experimental protocols. In fact, one of the greatest
advantages of this protocol is its adaptability. Because the choroid fissure, s-opsin expression, and rectus muscle landmarks have all been found
to reliably identify retinal orientation22 the landmark that best suits the experimental parameters can be chosen to optimize data acquisition
(Table 1). Additionally, methods of dissection can be combined so as to further clarify the orientation of the retina. For example, choroid fissure
cuts can be combined with s-opsin immunohistochemistry in order to orient all four poles of the retina: nasal and temporal hemispheres can be
identified by the choroid fissure cuts, and s-opsin immunohistochemistry can identify ventral and dorsal hemispheres. Yet, the adaptability of
this protocol may be constrained by the time-sensitive nature of physiology experiments. Because the time it takes to identify a landmark, make
a corneal burn, and execute a relieving cut could result in significant tissue death in ex vivo experiments, some of these dissection methods
may be less than optimal. Fortunately, once a dissector has become familiar with either the choroid fissure or superior rectus muscle dissection
method, identifying the deep landmarks and making the relieving cuts quickly become a part of the dissection routine and do not significantly add
to the length of dissection. Although we do acknowledge that the steps detailed here can add on time to extremely time-sensitive experiments,
we suggest using the s-opsin gradient for post hoc retinal orientation when the viability of the tissue is no longer an issue (Figure 3). Staining
the retina for s-opsin is an effective way to orient the retina, as it can identify all four poles: s-opsin staining divides the retina into dorsal and
ventral poles and allows for identification of the nasal and temporal poles depending on whether the retina is from a right or left eye (Figure

https://www.jove.com
https://www.jove.com
https://www.jove.com
https://www.jove.com/files/ftp_upload/57861/57861fig6large.jpg
https://www.jove.com/files/ftp_upload/57861/57861fig6large.jpg


Journal of Visualized Experiments www.jove.com

Copyright © 2018  Creative Commons Attribution-NonCommercial-NoDerivs 3.0 Unported
License

August 2018 |  138  | e57861 | Page 10 of 11

3). Therefore, we believe this protocol delivers a reliable and repeatable set of methods for accurate retinal orientation that can fulfill any
experimental parameters.

As with any modified retinal dissection, the validity of the dissection method is limited by the accuracy of the dissector and the quality of the
tissue that has been isolated. If any tissue is lost during dissection or a retina is too mangled for accurate reconstruction, Retistruct and the
MATLAB program will not be able to reliably reconstruct or orient the retina. It is therefore important to practice the dissection method before
using it for data-collecting experiments. While the types of dissections explained here are not difficult, they must be practiced to ensure the
repeatability of identifying retinal orientation with a particular landmark. Furthermore, it is essential that the dissector practice visually identifying
the anatomical landmarks prior to beginning data collection to make certain that the correct landmark is being used. One way to check the
accuracy of a particular dissector is to make either choroid fissure cuts or superior rectus muscle cuts and then compare the location of the cuts
to the s-opsin gradient, since it is a fixed marker and thus is not dependent on the accuracy of dissection. Potential dissectors can also compare
their reconstructed retinas to the examples of reconstructed retinas with accurate landmark cuts are shown in Figure 1 and Figure 2. Essentially,
a potential dissector should perform the steps outlined in this protocol for a particular dissection type, whether it be the superior rectus muscle or
choroid fissure method, and compare the results to the s-opsin gradient to establish the validity of a particular dissector. Because if the dissector
is unsure about the location of the landmark, it may result in an inaccurate orientation of the retina that will, by default, affect data collection and
interpretation.
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